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Warranty And Software Licence Agreement 

WestDev Ltd and Number One Systems 

This document contains the WESTDEV LTD SOFTWARE LICENSE AGREEMENT which will govern the use of the 
Westdev and/or Number One Systems' products supplied with it. 
You agree to the terms of this agreement by the act of opening the sealed package which contains the storage media on 
which the software is recorded. Do not open the sealed package without first reading, understanding and agreeing the terms 
and conditions of this agreement. If you do not agree to the license conditions you may return the SOFTWARE for a full 
refund before opening the sealed package.  
1. LICENSE AGREEMENT 
Ownership of the WESTDEV / NUMBER ONE SYSTEMS' Software Package and all its constituent parts supplied by 
Westdev Ltd ("LICENSED SOFTWARE") is not transferred to the Customer. Westdev Ltd hereby grants the Customer a 
non-exclusive license to use the LICENSED SOFTWARE on a single computer workstation. Each computer workstation, 
even on a network, must have its own separately LICENSED SOFTWARE. 
2. OWNERSHIP OF SOFTWARE 
As the LICENSEE, you own the magnetic, optical or other physical media on which the LICENSED SOFTWARE is 
originally or subsequently recorded or fixed, but an express condition of this License is that Westdev Ltd and/or the 
copyright owner retains title and ownership of the LICENSED SOFTWARE recorded on the original media and all 
subsequent copies of the SOFTWARE, regardless of the form or media in or on which the original and other copies may 
exist. This License is not a sale of the original SOFTWARE or any copy. 
3. COPY RESTRICTIONS 
This LICENSED SOFTWARE and all accompanying written materials and all other constituent parts are the subject of 
copyright. Unauthorised copying of the LICENSED SOFTWARE, including software which has been modified, merged, or 
included with other software, or of the written materials is expressly forbidden. You may be held legally responsible for 
any copyright infringement which is caused or encouraged by your failure to abide by the terms of the License. 
4. TRANSFER OF LICENSED SOFTWARE 
The Customer may transfer the LICENSED SOFTWARE provided that (i) this Software License Agreement is transferred 
with the LICENSED SOFTWARE, (ii) the transferee fully accepts the terms and conditions of this Agreement, and (iii) all 
complete or partial copies of the LICENSED SOFTWARE, including copies on data storage devices are also transferred (or  
destroyed). 
5. MODIFICATION 
You may not otherwise modify, alter, adapt, merge, de-compile or reverse-engineer the LICENSED SOFTWARE, and you 
may not remove or obscure any Westdev Ltd and/or Number One Systems' Copyright or Trademark notices. You must use 
all reasonable efforts to protect the LICENSED SOFTWARE, diskettes, and documentation from unauthorised use, 
reproduction, distribution or publication, or otherwise in violation of applicable law. Please contact our Customer Service 
department if you become aware of violations of Westdev Ltd's Copyright. 
6. TERMINATION 
The License is effective until terminated. You may terminate it at any time by destroying the LICENSED SOFTWARE and 
all complete or partial copies thereof. It will also terminate if you fail to comply with any term or condition of this 
Agreement. You agree upon such termination to destroy the LICENSED SOFTWARE and all complete or partial copies 
thereof. 
7. WARRANTIES 
No warranties are expressed or implied with respect to the LICENSED SOFTWARE described, its quality, performance, 
accuracy or suitability for any purpose. In no circumstances will the copyright holder be liable for direct, indirect, 
incidental or consequential damages resulting from the use of this SOFTWARE. 
8. OTHER SOFTWARE 
The supplied disks may contain software whose copyright is owned by third parties. This license agreement shall apply 
equally to this software except where the terms of this agreement are specifically modified by the copyright holder(s). Such 
modification(s) will be included in a machine readable file on the supplied disks. 
9. GOVERNING LAW 
The Governing Law of this Agreement shall be that of England. 
Westdev Ltd will reward anyone giving information leading to successful prosecution regarding breach of copyright. 
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Chapter 1. Getting Started 
Installation 

Installation is via the autorun setup. If you are not familiar with this process it is 
explained briefly below: 

Insert the CD-ROM into your CD-ROM drive and wait a short time. The CD-ROM will 
run up to speed and an Easy-PC Welcome screen will appear. If autorun has been disabled 
on your computer you must execute the 'setup.exe' program using the Start menu and 
Run command from the Windows task bar. 

The installation is the same for new and existing users alike. Existing users i.e. version 
V3.0 to V12.0 can install V13.0 over an existing installation without deleting the old one 
first. 

With the installer running, once the Welcome screen is displayed, double-click on the 
Install Easy-PC For Windows - Version 13.0 option, or click then press Run. 
Following the instructions on the screen, you should use the same Destination Folder for 
the Program Files as your existing Easy-PC program files e.g. C:\Program Files\Number 
One Systems\Easy-PC 

All other instructions should be followed until completion. 

Click Finish to complete the installation. 

Data Files Location 

There is now an extra step in the Setup installation wizard that asks you where you want 
to place data files (for example, libraries, technology files, etc). The default is always to 
use the common documents folder, “Users\Public\Documents\Easy-PC” on Vista, 
“Documents and Settings\All Users\Shared Documents” on XP etc. if you are installing 
for All Users, or into your own Documents folder if installing for current user only. 

Running Easy-PC For Windows 13.0 

As with all Easy-PC programs, an icon will appear in the Number One Systems folder, 
you may also wish to create an Easy-PC Shortcut icon that sits on your desktop. 

To start the program, double-click on the Easy-PC icon from the Number One Systems 
folder. 

Windows 2000 Support 

Support for Windows 2000 is withdrawn at the release of Easy-PC 13. Please visit the 
NumberOne.com web site for further information regarding our operating system support 
policy. 
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 Easy-PC For Windows V13.0 Supplement   9 

Chapter 2. New Features in Easy-PC V13.0 
Introduction 

All features are categorised as being SCM specific, PCB specific or Both (relevant to both 
SCM and PCB designs). 

Rulers (Both) 

You can choose to have vertical and horizontal rulers displayed along the left and top 
margins of an Easy-PC design window. Rulers can be useful for sizing or aligning design 
items in terms of physical units such as millimetres, inches or thou. 

 
Changing Ruler Settings 

To change the ruler settings, select Rulers from the View menu or right click on the rulers 
bar and use Ruler Settings from the context menu. 

The following dialog will be displayed: 
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From this dialog you may choose whether you wish to display a Horizontal ruler and/or 
a Vertical ruler or neither. This can be different for a PCB or a Schematic design.  

You can choose the Units to be used for the rulers scale from the dropdown list. If you 
select <Same as Design> the rulers will always shown the same units that are being used 
in the design, set up using the Units dialog.  

Setting the Align with Relative Origin option will make the rulers scale align zero with 
the Relative Origin rather than the Coordinate System Origin whenever Relative 
Coordinates are active.  

Ruler Stops 

You can define ruler stop positions on each of the rulers, displayed as a small line in the 
bar. You can also optionally display a full width/height line in the design where the ruler 
stops are defined. These lines are like grid dots, and cannot be selected in the design. 
They may help you to align and size items, or may be used as an alternative to a grid to 
snap items onto known positions. The ruler stop positions can be added by double 
clicking on the ruler bar, directly typed in, or created at the origin of the selected items in 
the design (see below).  

Ruler Stops will be saved with the design or symbol being edited. 

To display the Ruler Stops dialog, select Ruler Stops from the Settings menu, or right 
click on a ruler bar to use Ruler Stops from the shortcut menu, or alternatively, you can 
use a defined shortcut key or toolbar button. The following dialog will be displayed:  

 
The Settings tab contains the default colour of the ruler stops, both in the ruler bars and in 
the design. The visible check box is used to say if the stop lines are to be displayed in the 
design. These values can also be changed in the Display dialog.  

Check the Snap To Ruler Stops box if you want interactive operations on design items to 
snap to ruler stop positions. The When To Snap section defines how close the item needs 
to be to a stop position before it snaps onto it. The Always option makes ruler stops act 
like a grid, and the item will only move between the intersections of the stop lines.  

To set up the ruler stop positions, select the Stop Positions tab in the dialog. The 
following is displayed:  
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The two halves of the dialog page show the stop positions along both axes. Press the 
appropriate Add button to add a new stop position at the end of the list. Don't worry if the 
positions are out of order, they will be sorted into order the next time you enter the dialog. 
For each ruler stop enter the position, whether it has its own colour, and its own colour. 
Pressing the return key will add another stop to the bottom of the list, enabling you to type 
in a list of values using the return key after each entry.  

The ruler stop values will use the units defined for the ruler bars and will be relative to the 
zero position on the ruler bars. This will either be the relative origin (if defined and used 
by the rulers) or the system coordinate origin.  

Use appropriate Delete button to remove the selected ruler stop. Use Delete All to remove 
all stops in the list.  

You can drag ruler stops along the ruler to change their position and the Stop Positions 
table will be automatically updated with this new positional data. 

You can also double click on the ruler bar to add ruler stops without having to edit the 
ruler stops dialog manually. 

Rule Stop Settings 

You can right click on the ruler bars to use a context menu to access the dialogs 
mentioned above, and also to perform some other operations on ruler stops.  

 

 Use Delete All Ruler Stops to quickly remove all the stop positions from both axis.  
 Use Snap To Ruler Stops to toggle interactive snapping of design items to stop 

positions.  
 Use Add Ruler Stops at Selection Origin to add a horizontal and vertical stop 

position at the origin of the selected items. This command is available to put on a 
shortcut key, and is useful for displaying a line through particular items to use to line 
up other items.  
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If a ruler stop existed at the point that you right clicked on the ruler bar and one or more 
items of the same type are selected in the design, two Align To Ruler Stop options will 
be available. These allow you to Align either the lower or upper side of each selected item 
to the picked ruler stop position.  

If a ruler stop existed at the point that you right clicked on the ruler bar the Edit Ruler 
Stop and Delete Ruler Stop will be available to allow you to change the value of, or 
delete, the picked ruler stop. If no ruler stop was underneath the picked position, the Add 
Ruler Stop option is available. Use this to add a new stop at the position picked on the 
bar.  

A  new ruler stop can also be added by double clicking on the ruler bar.  

You can reposition a ruler stop by dragging it along the ruler by pressing and holding the 
left mouse button, release the button at the new location.  

Aligning to guide lines 

Also when selected, a ruler stop and one or more same type items are selected in the 
design then two of Align Left To Ruler Stop, Align Right To Ruler Stop, Align 
Bottom To Ruler Stop and Align Top To Ruler Stop will be available. You can use 
these ruler stop lines to align a single item, or multiple items of the same type, by right 
clicking on the ruler stop in one of the ruler bars and using one of the two Align options 
on the pop-up menu. This option works the same way as the Align functionality described 
above.  

An alternative to using the Align tool is to define Ruler Stop lines and interactively snap 
items onto these lines when adding shapes or moving items. The distance from the stop 
lines where snapping occurs can be set using the ruler stop settings.  

Some interactive options will snap to ruler stop positions, for example, Adding and 
Editing of shapes, Move and Move Corner of anything, etc. This is done by snapping to 
the positions if close enough, the snap distance is set up in the Ruler Stops dialog on the 
Ruler Settings menu. 
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Dual Screen Support (Both) 

Support for two monitors has been added to Easy-PC 13.  Use the Dual Screen tab for the 
Preferences option on the Settings menu to access the Dual Screen preferences dialog. 
This page of the Preferences dialog allows you to change how the application arranges 
separate instances across multiple monitors or on a single large monitor. 

 
How it works 

Check the Enable Dual-screen Support check box to turn on multi-screen operation. 
With this enabled, two instances of the application will work together to arrange your files 
so you can easily work on Schematic designs in one, and PCB designs in the other. Each 
instance will have its own menus and toolbars and work independently, but will share 
information when they need to. 

Windows for SCM and PCB designs 

This setting shows which window is used for each design type. Although it does not really 
matter which way round they are, instance #1 is the one that will be launched first if you 
run Easy-PC with no designs open. 

The small picture shows which design type will be displayed in which instance. To swap 
them round, simply click the 'swap' button. 

 
Windows for other file types 

As well as Schematic and PCB designs, Easy-PC is of course used to edit all your library 
items (parts, footprints, etc). You can choose where these should be opened for editing. 
You can choose either of the two specific program instances, for example you may wish 
to always edit library items in the same instance as your Schematic designs, or you can 
allow them to be opened in the instance in which the editing 'action' takes place. 
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Other Settings 

Open both windows on application start-up 

With this checked, both instances of the program will be started when you launch Easy-
PC. With it unchecked, launching Easy-PC will either start instance #1 (if no designs are 
open), or if you are opening a particular design file then it will launch the instance for that 
type of file. 

There is no recommended setting for this switch, it simply depends on how you prefer to 
work. The default setting is On. 

 
Exit in one window means Exit in both 

Check this box to make both instances close down if you close one of them. This makes 
them work more like a 'pair', but again it is simply down to how you want it to work. 

The default setting for this switch is On. 
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Part Editor Improvements (Both) 

Copy/ Paste Improvements in grid 

Component Editor dialog  

It is now possible to Copy and Paste data between the Component Editor grid and external 
applications such as Microsoft Excel and vice versa. A single cell or a range of cells can 
be selected for copying or pasting. It is also possible to paste the same value in to a range 
of cells. 

 
Using Copy and Paste To Edit Values 

The values in the Pin Assignments grid can be manipulated using the normal Copy and 
Paste techniques associated with spreadsheet applications such as Microsoft Excel. This 
includes the ability to copy and paste multiple rows and/or columns of data. One possible 
use would be to copy the pin data into an external spreadsheet to take advantage of 
advanced features such as sorting and filtering, then paste the modified data back in to the 
Part Editor. When pasting from an external source it is important to ensure that the data is 
arranged in the same order as the cells in the grid. 

The Copy and Paste commands are available from the context menu. Alternatively, the 
defined shortcut keys, by default Ctrl-C and Ctrl-V may be used. 

Selecting cells to copy or paste 

A single grid cell or a range of grid rows and/or columns may be selected for copy or 
pasting. Clicking on a single cell will select just that cell. If, rather than clicking, the 
mouse is dragged while the left button is held down a range of cells may be selected, 
indicated by being shown in reverse highlight. This range of cells can now be copied or 
pasted as a whole.  If a single cell has already been selected by clicking, it is possible to 
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extend this into a range of cells by clicking with the <shift> key held down. To quickly 
select an entire column click in its header cell. 

Pasting Values into the Grid 

When data is pasted into grid the values are subject to the normal constraints of the 
column into which they are being inserted and are checked in the same manner as when 
values are typed in. For example, a value pasted into the Sch Symbol Name column will 
be checked to ensure that it is a valid name of a symbol defined in the library.  

The Gate Name and Sch Symbol Terminal Name columns are read only and as such 
may not have values pasted into them although they may be selected and copied.  

If, when pasting a range of values, a single cell is selected in the grid, the cells affected 
will match the range of the paste values subject to the constraints of the rows and columns 
affected.  

By copying a single value then selecting a range of cells, it is possible to paste the same 
value into multiple cells. All cells in the selected range of cells will be set to the pasted 
value, subject to the column constraints.  

All paste operations may be reversed using the standard Undo facility. 

Component Values dialog 

The Component Values dialog has also been similarly modified to allow Copy/Paste 
to/from Excel or similar, although the values seen in Excel will include additional 
‘control’ tags used for the colour coding employed in the Component Values dialog. 

Import Pin Information 

You can import pin information into the component editor grid when editing a 
component. The Import Pin Information option is available from the Edit menu. 

 
Only pin values, and not gate or symbol values may be imported using this option. 

When selected from the Edit menu, you are presented with an Open dialog from which to 
choose the CSV file for import. 
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Once the required file has been selected, click the Open button to perform the import. 

If any problems with the import are detected, a report will be displayed showing the 
results of the import.  

Pin Data Format (CSV) 

Pin data may be imported in standard CSV format, such as can be created or manipulated 
in an external spreadsheet application such as Microsoft Excel.  

The first row of the CSV file contains the column headings for the pin information 
included. The column headings have to match those shown below but do not have to be in 
the same order and do not all have to be included. Omitted fields will be unaffected by an 
import.  

CSV column headings Corresponding Component Editor column headings 

pad number PCB Symbol Pad Number 

pin name Component Pin Name/Number 

terminal name SCH Symbol Terminal Name 

net name Net (Class) Name 

 

Either the pad number or the pin name field must be included to map the CSV rows to 
the appropriate pins in the Component Editor. If both fields are included, the pad number 
will be used to map the pin name, and any other included fields, to the appropriate 
Component Editor pin.  

If Terminal Name values are included, they will be assigned to all gates of the same type 
as the one to which the included pins are mapped.  

The CSV file does not have to include entries for all the part pins. Those pins not present 
will be unaffected by the import thus allowing partial pin assignments to be made. The 
import report will contain a warning if not all pins are included as a precaution against 
accidental omissions.  
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An example pin information CSV file is shown below: 

Pad Number,Pin Name,Terminal Name 
1,L09,__RESET 
2,H01,CLKIN 
3,G01,XTAL 
4,J01,CLKOUT 

Apply Increment to Selected Cells 

The Apply Increment to Selected Cells option is available on the context menu when an 
appropriate range of cells is selected cell for Component Pin Name/Number cells in the 
Component Editor. This can be used to name one cell and create an incremental 
sequence from it to each subsequently selected cell.  

 

 To use Apply Increment to Selected Cells 

1. Name the first cell, A1 for example. 

2. Select the first cell and the next 14 cells by dragging the mouse over them. 
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3. Select Apply Increment to Selected Cells option from the context menu. 

 
4. The Name/Number range will now show A1, A2, A3, A4, A5 etc. in the selected 

cells. 

Pan and Zoom Improvements (Both) 

You can now change the Pan and Zoom sensitivity and direction of movement using 
sliders and check boxes on the Settings menu, Preferences dialog under Display. 

 
The sliders will provide you with the sensitivity required. Moving them to the left will 
mean they are less sensitive. When rolling the mouse backwards or forwards, the effect of 
this will be that the zoom is slower or faster, i.e. bigger or smaller increments. 

Checking the Reversed Mouse Zoom/Pan check box will reverse the current direction. 
For Pan, we recommend checking this box, this will also be the new install default. The 
Revere Pan direction will enable Easy-PC to work more like some other products like 
Adobe Reader. 
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Find using Extended Values (Both) 

The Find dialog within the Library Manager and Add Component dialog has been 
extended to allow up to 4 component values (attributes) to be used for searching. Values 
can also be compared using the same ‘operators’ as the Name (is, begins with, contains).  

Also added is the ability to save search settings to a file and load them again, meaning 
commonly used searches can be kept. You can use as many or as few values as you like to 
refine the search. 

 

Report in Library Manager (Both) 

The Component Library report (run from within the Component Library Manager) now 
shows the name of the looked up symbol library rather than the 'originating' symbol 
library. That is, the name of the library from which the symbol will be loaded when the 
component is added to a design.  
When running the Component Library report there is an additional prompt asking Show 
library folders for symbols. If answered Yes, the report will show the full folder path for 
each looked up symbol library as well as its name.  

Project Print (Both) 

You can now choose to print to PDF from the project level. This output is available on 
the File menu and Print. The Print Project dialog presents you with an additional radio 
button to select the PDF output. 
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PDF Plot (Both) 

When using the Plotting and Printing option (from the Output menu), you can define a 
margin to be applied around a PDF plot. This is available on the PDF setup dialog under 
Options and PDF. 

The Plot Margin is defined using the units shown on the dialog. These can be changed by 
selecting the units button. 

 

Colour for moving items (Both) 

There is a new check box, Moving Items Use Sel Colour, on the Settings menu, 
Preferences dialog under Display. 

When selected, this retains the existing behaviour of drawing the selected moving item(s) 
in the selection colour, the default setting is On (checked).  

When unchecked, dynamic selected items are instead drawn in their normal colour, so 
when adding tracks for example, you can see by the colour which layer the current 
segment is on, instead of just seeing it in the selected colour. This option has been added 
to aid some situations, when editing a track for example, where it might be better to 
actually see the normal colour of the selected segment. 
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Status Bar (Both) 

For selected items in a design, you can now show its position on the Status Bar. The 
position of Components, Pads, Text, Vias and Callouts is available under Pos:. 

 

Barcode Text (Both) 

You can add barcodes into your design by adding text with a special barcode style. 

To do this, can now define a barcode text style, only named barcode styles defined 
through the Technology dialog are allowed. To enable barcodes, you must use the 
Barcode Interleaved 2 of 5 text font. Once this is selected, you can then define the bars 
and gaps used for your barcode. 

 
In the design, use the Add Text to add the numbers that will define the barcode, i.e. 
05505223. Then change the text style of the barcode to your barcode font and the design 
will now display a barcode. Until this special barcode font is used, the text will still 
appear as normal readable text. 

 

Bitmap Import Supports JPEG and TIFF Formats (Both) 

You can now import bitmaps in JPEG and TIFF formats as well as bitmaps. 
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Move From Bin (Both) 

When dragging a multiple selection from the Component Bin, it now uses the Arrange 
method of stacking components by Component Name instead of simply placing them in a 
single vertical line. This makes them easier to manage and place, and less likely to be 
spread off the working area or screen. 

Draw ‘Empty’ Value Positions (Both) 

There is a new check box on the Setting menu, Preferences dialog under Display to 
Draw Empty Value Positions.  

 
When checked, any value position that resolves to an empty string will be drawn as <?> 
instead. This is required because it is possible through the Properties dialog to have 
component values that have no text, e.g. by turning off all but Reference Name and then 
also turning off Name on the Component tab. From this you have value positions that 
you cannot see or pick, so they are using text styles but you cannot find them to change 
style, this new option will solve this. 

Display of Component Value (Both) 

From within the Display dialog and Layers and Layer Spans tab, under Values you can 
now switch off component values in the design, values such as component name for 
example, and change the colour (this previously used the Symbol Text colour). 
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Highlights/Drawing (PCB) 

There are new highlight check boxes and colours on PCB colours (Display) dialog. 
Changes have been made for the following: 

 Tracks fixed for Router (centre-stripe or whole colour as per existing ‘angled’ 
highlight). 

 Lowlight Fixed Items (dims colour of pads and shapes of items that are fixed). 
 Unplated Holes (draws small ‘diamond’ inside drill hole, only visible if Draw 

Drills is enabled in the Preferences dialog under Display). 
 

 

Bitmap Visibility and Picking (Both) 

The ability to set the visibility and selectability of Bitmaps on the Display dialog has 
been added.A check box on this dialog for Bitmaps will toggle through the three states. 
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Change Net Colour (Both) 

When selecting a net or track (in PCB), on the context menu from the Nets > sub menu, 
you can now access the Change Net Colour option. 

 
This dialog provides access to the net own colour and show connections switches and net 
colour. This is the same as the settings available on Nets page of the Display dialog. 

 
When accessing this in a Schematic design the Change Net Colour is directly on the 
context menu and there is no Show Connections check box. 

Least Used Menu Option (Both) 

The ability to hide the least-used menu options has been added. This simplifies the menus 
and hides options which are less used. Items hidden can be revealed by selecting the small 
double-down arrows on the menus. 

 
If you wish to have the full menus as before, the switch for this option is available under 
Personalised Menus and Toolbars from the Settings menu, Customise and Options 
page. 
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Reset my usage data 

This resets the menu commands shown on the short version of a menu to the original set. 
It does not change the location of toolbars, nor reset any buttons or commands moved, 
added or removed by using Customise. 

Report File Extensions (Both) 

There is a new check box on the Preferences dialog and General page, this enables the 
ability to output all reports to a .TXT file extension instead of the existing drr, dcr, xyz, 
etc. file extensions. 

 
The output report will use the design type and title of report to form the pathname, for 
example “Design123 (PCB – Design Status Report).txt” 
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Draw Screen Grid as Lines (Both) 

From within the Grids dialog, the Primary and/or Secondary screen grids can now be 
drawn as lines instead of dots. 

You can also opt for them to be drawn before instead of after the design contents using 
the check box Draw Grid First on this dialog. 

 

Technology Dialog – Copy Style As (Both) 

There is an extra button, Copy Style As, for Styles on the Design Technology dialog to 
add a new style based on the one currently selected in the grid. 

 

Online Manuals Menu (Both) 

There is a new sub-menu on the Help menu from which you can access PDF documents 
installed on your system. 
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Library Dialog – Close on Edit (Both) 

There is a new check box on the Libraries dialog that allows you to choose whether or 
not the dialog should be closed after opening a library item for edit. 

 
This enables you to open  a series of components for editing without it closing each time. 

Design Rule Check Report (Both) 

New report are available on the Output menu and Reports for Design Rules Check report 
when in SCM or PCB. This reports DRC errors within the design without the need to run 
the DRC option. 

Flip Bus Terminal (SCM)  

If bus terminals are selected, they are individually flipped so that the bus end moves and 
the connection end stays where it is if it can. You can also select multiple bus terminals 
and they are flipped individually and not as a group. 

Spice support for LT Spice (SCM) 

Netlist support for the free Linear Technology (LT) Spice product has been added to 
Easy-PC 13. 

 
First choose the Simulator Format for the simulation file. The output file will be 
formatted to suit the chosen simulator.  

Use the Output File Name box to provide the name for the simulation output file.  
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If available you can use Run Simulator to specify whether to run the simulator after the 
netlist has been generated. Use the Browse button to locate the program to be run on your 
computer. Where possible we have added filters to this dialog to suggest a possible 
simulator program name.  

Add any command line switches that are needed to run up the simulator, either before or 
after the output filename. Initially these will be set to default values for each simulator 
type. If you change them you can use the Reset button to revert back to the default values.  

Press OK to continue with the simulation output process. If the output file already exists 
you will be asked for permission to overwrite it. 

LT Spice library 

An LT Spice Component and Symbol library is available on 
www.numberone.com/spicesupport.asp page under the LTSpice heading. 

Retrieve From Bin (PCB) 

If components in PCB have been moved from the design to the Component Bin, the new 
Retrieve From Bin command is available by right clicking on one of the components in 
the Bin. This will return the selected item(s) to their previous location on the board. 

 

Swap Between Gerber RS-274-X and RS-274-D using a button (PCB) 

Two new buttons have been added to the Gerber setup dialog within the Plotting and 
Printing option to facilitate swapping between the Gerber RS-274-D and RS-274-X 
formats. 

 

www.numberone.com/spicesupport.asp
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Extra check to Ignore Net Class track styles (PCB) 

There is a new switch in Preferences and PCB Tracks labelled Don’t use Track and 
Via Styles from the Net Class. Check this box to always use the styles from the defaults 
dialog when interactively adding or editing tracks and vias. If this isn’t checked, it will 
use the styles defined for the Net Class. 

 

Additional Pad Shapes (PCB) 

You can now define target and annulus pad shapes for use in your designs. 

 
For a target, you can define the line thickness used. 

For annulus, you can define the inner ring size in the Technology dialog when editing the 
Pad style. 
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Shape Properties – Shape Area (Both) 

On selection of a shape, the Properties dialog shows the total area value in the current 
design units. It includes the total area with and without taking into account the line style 
thickness. 

 

Track Length Rules on Net Classes (PCB) 

You can now add new values on a net class: 

 length difference value 
 min length value 
 max length value 
You can optionally enable the Maximum Track Length Difference and Min and Max 
Track Lengths options within the net class. 

 
By adding these values and using the appropriate net class in your design, you can define 
a minimum and maximum length that the routed track must finish with. By adding a 
length difference value to the net class, you can then check that all the tracks using that 
net class will finish with their length within that tolerance. Either value can be set to zero 
to ‘ignore’ that length. 

These new values are used by a new DRC check (Net, Track Lengths), and a new Track 
Length Rules report available from the Output menu and Reports. 

DRC Option 

Within the DRC option, the Track Length Diffs calculates length of all tracks in the 
class, finds the median value, then shows you any net that is too far either side of this 
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value. The same check box enables the Min/Max check to simply verify track length of 
each net against specified values. Nets with no tracks are always flagged as errors. 

 
DRC Report 

When the DRC option reports Track Length Diffs errors, the report typically might look 
like this: 

Design Rule Check Report 
------------------------ 
Report File    : c:\temp\ProRouter.txt 
Report Written : Saturday, July 04, 2009 
Design Path    : c:\temp\ProRouter2.pcb 
Design Title   :  
Created        : 22/04/2004 1:28:41 PM 
Last Saved     : 06/07/2009 10:47:57 AM 
Editing Time   : 6470 min 
Units          : thou (precision 4) 
 
Results 
------- 
Track length differs from other nets of same class : Net N0009 
too long, length is 602.7795 thou but needs to be no more than 
600.0000 thou from rules in net class HS1 
 
Net N0009 too long, length is 602.7795 thou but needs to be no 
more than 600.0000 thou from rules in net class HS1. 
 
Number of errors found : 1 

 

Track Length Rules 

This report, available for PCB designs, analyses the tracks in the design to determine 
those that comply with the length rules defined in their net class. 

The results produced by this report are listed by net class name, showing only those net 
classes which have length rules (Difference, and/or MinMax Length). For each one, it lists 
the rules, then lists each net that uses the net class. For each of those nets, it will show the 
actual length, the expected range of lengths of all nets within the class, and an indication 
of whether this net passes or fails the length rules. 
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When run from the Output menu and Report option, an example Track Length report 
might look like this: 

 

Track Length Rules 
------------------ 
 
Report File    : c:\temp\ProRouter.txt 
Report Written : Saturday, July 04, 2009 
Design Path    : c:\temp\ProRouter2.pcb 
Design Title   :  
Created        : 22/04/2004 1:28:41 PM 
Last Saved     : 06/07/2009 10:47:57 AM 
Editing Time   : 473 min 
Units          : thou (precision 0) 
 
---------------------------------------------------------------------------------- 
Net Class Rules      | Net  Actual Expected range                  
Name Diff Min   Max | Name   Length From   To 
Fail 
---------------------------------------------------------------------------------- 
HS1 15.0000 580.000    600.000 | N0009 602.779 590.315 605.315    
**** 
       | N0010 592.850 590.315 605.315         
---------------------------------------------------------------------------------- 

 
Net Class –  This is the net class name that the rule applies to. 

Rules Diff –  This is the value defined by you in the rules dialog. 

Min/Max –  These are minimum and maximum lengths that you have 
defined for the net class. 

Net Name –  The actual net name of the net using this net class. 

Actual Length –  This is the actual length as measured in the design. 

Expected Range From/To –  The 'expected range' for the overall track length is worked 
out from the actual lengths of the nets in the net class. 
Those with no tracks are ignored, all the others are 
collected into a table and the median value is used as the 
expected length. The range shown is therefore the 
deviation allowed from this median value. If there are less 
than four nets using the net class, the average length of 
those nets is used instead of the median value. 

Fail -  Four **** will indicate clearly that the net fails the rules 
defined. 
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Composite Power Planes (PCB) 

From within the Plotting and Printing option, you can now plot Positive (plane & 
items) plots when outputting power planes with embedded items (such as tracks or text). 

 
The net effect of a plane & item plot is that no additional composite of the plane is 
required and only one plot is supplied to your manufacturer. Previously, two plots were 
required which would then be combined and a composite produced. 

A final composite plot might look something like this: 
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Testland Vias on resist plots 

On the Settings page of Plotting and Printing dialog for resist/paste plots (with Pads-
Only selected) is a separate check box for enabling Testland vias. This allows ‘normal’ 
vias to be covered with resist whilst leaving Testland vias clear. 

 

3D View Changes (PCB) 

The background colour on printing can now be forced to white using the Print with white 
background check box enabled. Enable this from the 3D Settings dialog on the View 
menu and under the Settings tab. 
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Named Areas (PCB) 

You now have the ability to name any area using the Properties dialog. 

 
Naming an area allows it to be referenced by name in the Arrange Components and 
Autoplace options. 

 

Arrange Components (PCB) 

There is a new command on Tools menu under Auto Place called Arrange Components. 

 
This can be used to help you group together 'sets' of components in your PCB design as an 
aid to the initial placement on the board. These components are arranged in 'stacks' by 
component and package to make it easier for you to manage. 
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What to place 

Choose which components you would like to arrange. Some of the options may be greyed 
out, in the above example there are no components selected in the design and no groups 
defined.  

You can choose from All components, Selected components, from the component Bin, 
from components in a Group or from a schematic Sheet. 

Where to place 

Choose where to put the chosen components. As this command is intended as an aid to 
manual component placement, the components will be placed 'above' the chosen location. 
For example if you choose 'Above First Board', then the start point for the arrangement is 
the top left corner of the bounding box of the first board outline in the design. The 
exception to this is Moving With Cursor when the arranged components will be moving 
around for you to place interactively. 

You can place Above first board outline, above a Selected Board outline, above a 
Named Area and Moving with Cursor. 

When run, this option stacks up the components by Component Name (part) and Package, 
(the same as Translate to PCB does if you don’t use the Component Bin). 
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Sheet Names in PCB (PCB) 

Components in the PCB design can know which Schematic sheet they come from. This is  
useful for a project that has multiple sheets. 

Setting the Sheet Names to PCB option 

From the Settings menu and Preferences, there is a new check box, Sheet Names to 
PCB, under the General tab and Integrity Check. When selected, this enables Translate 
to PCB to set initial sheet names on components as they are added to the PCB, and 
enables Integrity Check to synchronise sheet names from Schematic to PCB. 

 
Properties 

The Properties dialog for a selected component shows the sheet name. 

 
Once the PCB has sheet names on the components, you can use these in the following 
options: 

Component Bin: from the context menu and using Select All On Same Sheet by 
choosing from the dialog showing a list of sheets, or Select All On Sheet xxx, if the 
component already selected that is on a sheet, to select all the components that originate 
from the same schematic sheet.  

In Select Mode: use Select All From Sheet from the context menu, this is the same as 
Select All On Same Sheet, above. 
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In Autoplace using Match to Area Names: by choosing to place only those components 
originating from a particular sheet. Use the Sheet button to enable this. However, it will 
consider components originating from the named Schematic sheet. This option is only 
enabled if the PCB design has sheet information from the Schematic sheets in the Project. 
The named area must use the same name as the sheet for this to work. 

DXF Output Improvements (PCB) 

From the DXF output option on the Outputs menu, you can now Mirror the output or 
output the Drill Drawing idents. These are both selected from the dialog using check box 
selections. 

 

Show Nearest Node On Net (PCB) 

There is a new PCB option on context menu when adding a track or sketching, called 
Show Nearest Node on Net. Use this option to show a line to the nearest item on the net 
to the end of the track being added. The option is also available on the PCB Tracks tab in 
the Preferences dialog. Autoroute will route this line (if not editing a connection). 
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Next/Previous Layer Command (PCB) 

Two new commands are available for cycling through available layers during most 
interactive editing of shapes and tracks. These are available on the context menu as Next 
Layer and Previous Layer. These commands can also be assigned to shortcut keys using 
the Customise dialog. 

 

Change Layer option (PCB) 

The Layer drop-down list, is now ‘pre-dropped’ like the Change Style dialog. This new 
style dialog also auto-numbers the electrical layers to make it easy to access by key. If 
there is only one possible layer swap, e.g. from top to bottom layers, it will not display 
this dialog. So typing ‘4’, will select the 4th electrical layer. 
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DRC for ‘Vias in Pads’ (PCB) 

An additional manufacturing check on the DRC dialog will flag same-net pad-to-via 
errors if a via touches a pad (no spacing is applied, the via must touch pad to cause an 
error). 

 

DRC ‘Text shapes’ (PCB) 

When checking text (either with Spacing Text check or Manufacturing Silkscreen 
check selected), with the Check Text Shapes option selected, it will force the check of 
the actual shapes/strokes of the text characters instead of just the bounding box. With it 
left unchecked, the bounding box is used. 
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DRC Silkscreen information (PCB) 

When an error for silkscreen text/shape over pad/via, more information is now included in 
the error description, such as text or shape and pad name. 

For example: 
Via to Silkscreen Error (V-S) at (10135 11350) on Layer "Top 
Silkscreen". Silkscreen text 'IC2' overlaps via 
 
Pad to Silkscreen Error (P-S) at (6325.0000 8250.0000) on 
Layer "Top Silkscreen". Silkscreen text 'R1R 0.063W...' 
overlaps pad. 
 
Pad to Silkscreen Error (P-S) at (13777.5000 12697.5000) on 
Layer "Top Silkscreen". Silkscreen text 'U32' overlaps pad. 

DRC Component-to-Component (PCB) 

It is now possible to define and check the space between components. You can check 
(using the Spacing Components option in DRC) the space between components using 
the placement extents of a component and its bounding box (the bounding box includes all 
shapes and pads of a component). The required minimum distance between components is 
defined in the Design Technology and Rules. 

There are two methods to define the ‘bounding’ box. The first is to let Easy-PC define it 
for you using the maximum extents of the shapes and pads of the component, or to define 
the bounding box yourself using a placement area. 

Defining a placement area 

Any shape on the top or bottom layer can be defined as a Placement area by putting it on 
a placement layer. You can set a layer to be a placement layer by using the Layer Types 
dialog. A new check box under Layer Types for Placement Shapes should be checked to 
enable this feature.  

 
Once checked, when the DRC option for Spacing and Components is selected, the 
shapes defined on that specific layer will then be checked. If a component does not have a 
placement area defined on one of the placement layers (top or bottom), the bounding box 
of the component extents will be used. 
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DRC dialog 

 
If you also check Board under Spacings on DRC dialog, it will also check for 
components outside the board outline. 

Spacing dialog 

The Component Spacings are defined on the Rules page of the Design Technology 
dialog. You can specify different Component to Component Spacing values for the Top 
Side and Bottom Side. 

 

Sign-Off Checks (PCB) 

Two sets of DRC settings are now stored in the design (these were stored in your system 
registry). One of these two sets is the Sign-off check set, and is used at the start of the 
Plotting process to check your design before producing outputs. 

The Sign-Off checks are used as a final verification that your design conforms to the rules 
you’ve specified. It highlights important information, errors and warnings the moment 
before you send off your plots to be manufactured. It will ensure you remember to run the 
DRC checks and will highlight the errors to you at a critical time in the design process. 

DRC option 

There are two sets of DRC settings stored in the Design. You can use the Load and Save 
buttons in the lower left corner of the dialog to load either of the two sets into the dialog, 
and save the current dialog settings away to either set. 

 Normal - The first is the 'normal' set that is used when running Design Rule Check.  
 Sign-off - The second is a 'sign-off' set that is used when running the Sign-off 

Checks prior to producing plots.  
Note: When you click the Run button on the Design Rule Check dialog to start the 
checking, whatever settings are present in the dialog at that time will be saved to the 
'normal' set. 
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Plotting dialog 

An additional check box on the Plotting Options dialog is used to enable the Sign-Off 
Checks when the plots are generated. 

 
There is an additional button on the Options dialog to setup the Sign-Off checks. This is 
a reduced version of DRC dialog showing only settings, and main DRC dialog has 
controls for saving and loading both sets of settings. 
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The Sign-Off Checks button displays a reduced set of DRC options to enable you to 
select the rules to check. 

 
ODB++ Dialog 

The ODB++ dialog also has the Sign-off checks check button to enable to run the rules. 

 

 ‘Accepted’ DRC Errors (PCB) 

Error markers in Easy-PC can now be ‘accepted’ (as ‘signed-off’). You may find that 
DRC finds errors which you are prepared to accept (or 'sign off'). This might happen for 
example if you have a set of 'finger' pads touching the edge of the board. DRC will flag 
these with 'Pad to Board' errors, which you can then set as 'Accepted' so that there is a 
positive indication that you have examined these errors and agree that they are not faults 
that need to be fixed. Once you have resolved all the faults in the design except those that 
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you are prepared to sign off, you can use the Accept Existing Errors button to mark all 
remaining errors as accepted. Alternatively an error marker can have its Accepted 
property toggled using the Properties dialog or by right clicking an error and selecting 
the option from the context menu. 

Accepted error markers are only deleted by you, either by deleting them interactively in 
the design, or using the Delete Accepted Errors button on the DRC dialog. When you 
run Design Rule Check, any existing accepted errors are left alone. 

Accepting errors 

Individual errors can be checked as Accepted on Properties. 

 
DRC dialog 

The DRC dialog has some new buttons to help with clearing and accepting existing 
errors. These are listed under the Existing Errors section: 

The buttons in this section are used to deal with existing error markers in the design. 

 Delete All Errors : removes all existing error markers from the design.    
 Delete Normal Errors - removes all existing error markers that are not set as 

'Accepted' errors.  
 Delete Accepted Errors - removes only existing error markers that are set as 

'Accepted' errors.  
 Accept Existing Errors - use this button to mark all existing error markers as 

'Accepted'. 
On running DRC, the option will only delete ‘normal’ errors and will leave Accepted 
errors in-place. 
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Display dialog 

There are different colours and visibility settings on the View menu and Display dialog 
under Layers and Layer Spans and Accepted Errors. 

 
Find Error types 

From the Goto bar, on selection of Errors, you can now list errors by type. From the 
context menu within the Goto bar, you can select List All Errors, List Only Normal 
Errors and List Only Accepted Errors. 

 
When showing all errors, they are separated into two lists, normal and Accepted so they 
are easily visible. 
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Specctra Export menu option (PCB) (Existing Cost Option) 

There is a new menu option to simply write DSN file without attempting to launch the 
Specctra product. This is only available for users who have purchased the Specctra 
interface cost option. 

From the Tools menu, select Specctra Router > and Write DSN File from the sub menu. 

 
A small dialog is displayed in which to enter the folder where the DSN file is to be 
written. 

 

GenCAD Output (PCB) (New Cost Option) 

A new cost option is available in Easy-PC 13 to output GenCAD format files. 

The GenCAD format is used to transfer physical design information to other software, 
usually for more advanced test or manufacturing purposes. The Easy-PC GenCAD output 
option conforms to the GenCAD V1.4 specification. 

 
Use the dialog to select the output features you need. The options selected will depend on 
the requirements of the software into which you are going to read the resulting GenCAD 
file. Please check with the person requesting this format file before outputting it. 
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Micro Library Update (Updated Cost Option) 

An additional 500 micro controllers have been added to the existing Micro-controller 
library. This upgrade is supplied free of charge when you upgrade to version 13 or as a 
chargeable option if you decide not to upgrade to version 13.. 

A full list is supplied online in the Micro-Controller datasheet. 
www.numberone.com/downloads/datasheets/MicroLibrary2.pdf  

Pro Library Update (Updated Cost Option) 

Over 13,000 new Components and associated symbols/footprints for this existing library 
have been added to version 13. Users who have also purchased this library can purchase 
the upgrade from our sales office. 

A full list is supplied online in the Pro-Library datasheet. 
www.numberone.com/downloads/datasheets/ProLibrary2.pdf 

Connector Library (New Cost Option) 

A new library of over 22,000 new Connector components has been added to version 13. 

A full list is supplied online in the Connector Library datasheet. 
www.numberone.com/downloads/datasheets/ConnectorLibrary.pdf 

 

www.numberone.com/downloads/datasheets/MicroLibrary2.pdf
www.numberone.com/downloads/datasheets/ProLibrary2.pdf
www.numberone.com/downloads/datasheets/ConnectorLibrary.pdf

